LENESANS Release Note

RZ/N2H Group
Encoder I/F HIPERFACE DSL Safety sample program

Summary
This document describes the RZ/N2H Encoder I/F HIPERFACE DSL® Safety sample program package.

Functionality Checked Device
RZ/N2H Evaluation Board (RTKORZN2HXXXXXXXXX)
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RZ/N2H Group Encoder I/F HIPERFACE DSL Safety sample program

1. Package Contents
This package contains the following contents.

The RZ/N2H encoder interface supports up to 13 axes, but the sample program uses only 1 axis of them. If
you use with 2 axes or more simultaneously, modify the sample program to support required axes.

1.1 Software
e Source Code

No. Name Version number
1 RZ/N2H HIPERFACE DSL Safety sample program (CR52 ver. *) 4.0
2 RZ/N2H HIPERFACE DSL Safety sample program (CA55 ver. *) 4.0

Note: This sample program has a CR52 version that runs on the CPU core Cortex-R52 and a CA55 version
that runs on the CPU core Cortex-A55. CR52 ver. and CA55 ver. are descriptions of the respective
version.

1.2 Document

No. Document name Version File name

1 RZ/N2H Group Encoder I/F 4.00 (j) r11an0974jj0400-rzn2h.pdf
HIPERFACE DSL Safety sample (e) r11an0974ej0400-rzn2h.pdf (this document)
program Release Note

2 RZ/N2H Group HIPERFACE DSL 4.00 (j) r11an0970jj0400-rzn2h-hfdsl-safety.pdf
Safety Sample Program Application (e) r11an0970ej0400-rzn2h-hfdsl-safety.pdf
Note
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RZ/N2H Group Encoder I/F HIPERFACE DSL Safety sample program

2. File Structure

The file structure and contents of this package are detailed below.
Top
F— r11an0974jj0400-rzn2h.pdf
F— r11an0974ej0400-rzn2h.pdf

L— workspace

— Software

| — iccarm

| | }— RZ_N2H_CR52_hfdsl.zip : RZ/N2H HIPERFACE DSL Safety

| | | Sample program CR52 ver. (IAR) set
| |  L— RZ_N2H_CAS55_hfdsl.zip - RZ/N2H HIPERFACE DSL Safety

| | Sample program CA55 ver. (IAR) set
| — gcc

| F— RZ_N2H_CR52_hfdsl.zip : RZ/N2H HIPERFACE DSL Safety

| | Sample program CR52 ver. (e? studio) set
| L— RZ_N2H_CA55_hfdsl.zip : RZ/IN2H HIPERFACE DSL Safety

|

Sample program CA55 ver. (e? studio) set
L— Documents

— r11an0970jj0400-rzn2h-hfdsl-safety.pdf

L— r11an0970ej0400-rzn2h-hfdsl-safety.pdf

The file structure of the RZ_N2H_CR52_hfdsl.zip and the RZ_N2H_CA55_hfdsl.zip is shown below.

Top folder
— configuration.xml : FSP Configuration data
— ( Environment File Depending on Build Tool )
L— src
— hal_entry.c : HIPERFACE DSL Safety sample program
— hfdsl_main.c : HIPERFACE DSL Safety sample program
— siochar.c : SCI_UART sample program
— syscalls.c : SCI_UART sample program
— sio_char.h : SCI_UART sample program
L— drv
L— hfdsl
— iodefine_hfdsl.h : HFDSL register definition file
— r_hfdsl_rzt2.c : HFDSL driver file
F— r_hfdsl_rzt2_config.h : HFDSL driver file
F— r_hfdsl_rzt2_dat.h : HFDSL driver file
L— r_hfdsl_rzt2_if.h : HFDSL driver file
R11AN0974EJ0400 Rev.4.00 Page 3 of 15
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RZ/N2H Group Encoder I/F HIPERFACE DSL Safety sample program

3. About HIPERFACE DSL Safety Sample Program

This section contains information necessary to use the complete set of HIPERFACE DSL Safety.
3.1 Software Information

3.1.1 Base OS

This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program and HFDSL driver is shown in the following table. This table does
not include the memory size used by Flexible Software Package or C language libraries of the compiler.

(1) CR52 ver.

ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
HFDSL driver Code 6.3 4.1
Data (with initial value) 0.0 0.0
Data (without initial value) 0.8 0.8
Constant Data 0.6 1.6
Sample program Code 2.7 3.1
Data (with initial value) 0.0 0.0
Data (without initial value) 04 04
Constant Data 1.2 0.1

(2) CADS55 ver.
ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
HFDSL driver Code 9.0 6.6
Data (with initial value) 0.0 0.0
Data (without initial value) 1.1 1.2
Constant Data 0.9 2.7
Sample program Code 44 54
Data (with initial value) 0.0 0.0
Data (without initial value) 0.4 0.4
Constant Data 1.3 0.1
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RZ/N2H Group Encoder I/F HIPERFACE DSL Safety sample program

3.2 Hardware Information
3.21
RZ/N2H

Device

3.2.2 Target Board
(1) Board Name

RZ/N2H Evaluation Board (RTKORZN2HXXXXXXXXX)

(2) Setting of the Target Board
The target board configuration is as follows. Do not push SW4 while you are using channel HFDSL14.
DSW2-4: ON, DSW2-6: OFF
DSW5-1: OFF, DSW5-2: OFF, DSW5-7: OFF, DSW5-8: OFF
DSW7-3: OFF, DSW7-4: ON
DSW12-5: ON, DSW12-6: OFF, DSW12-7: ON, DSW12-8: OFF
DSW13-1: OFF, DSW13-2: ON, DSW13-3: OFF, DSW13-4: ON, DSW13-7: ON, DSW13-8: OFF
DSW18-5: OFF, DSW18-6: ON
DSW19-3: OFF, DSW19-4: ON
DSW20-1: OFF, DSW20-3: OFF, DSW20-5: OFF
DSW21-2: OFF, DSW21-3: ON, DSW21-4: OFF, DSW21-5: ON, DSW21-6: OFF
DSW3-1: ON, DSW3-2: OFF, DSW3-3: ON, DSW3-6: OFF (Set xSPI1 boot mode)
JP8: Short between 2-3 pins (Set VDD1833_2 to 3.3 V)
JP9: Short between 2-3 pins (Set VDD1833_3 to 3.3 V)
JP23: Short between 1-2 pins, Open between 3-4 pins, and between 5-6 pins (Set VDD1833 6 to 3.3 V)

(3) Used Pins of the Target Board

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as
follows. Channels HFDSL8, HFDSL12 and HFDSL15 are not available.

Channel Port Name Pin Header | Input/Output Voltage Description
Domain

HFDSLO ENCIFDIOO (dsl_in) CN44 #9 Input VDD33 Data input
ENCIFDOOQO (dsl_out) CN44 #7 Output VDD33 Data output
ENCIFOEOQO (dsl_en) CN44 #5 Output VDD33 Drive/receive control

HFDSLA1 ENCIFDIO1 (dsl_in) CN44 #8 Input VDD33 Data input
ENCIFDOO01 (dsl_out) CN44 #6 Output VDD33 Data output
ENCIFOEO1 (dsl_en) CN44 #4 Output VDD1833_5 | Drive/receive control

HFDSL2 ENCIFDIOZ2 (dsl_in) CN43 #23 Input VDD33 Data input
ENCIFDOO02 (dsl_out) CN43 #21 Output VDD33 Data output
ENCIFOEOQ2 (dsl_en) CN43 #27 Output VDD33 Drive/receive control

HFDSL3 ENCIFDIO3 (dsl_in) CN43 #24 Input VDD1833_6 | Data input
ENCIFDOOQ3 (dsl_out) CN43 #22 Output VDD1833_6 | Data output
ENCIFOEOQ3 (dsl_en) CN43 #18 Output VDD1833_6 | Drive/receive control

HFDSL4 ENCIFDIO4(dsl_in) CN44 #27 Input VDD33 Data input
ENCIFDOO04 (dsl_out) CN44 #25 Output VDD33 Data output
ENCIFOEO04 (dsl_en) CN44 #23 Output VDD33 Drive/receive control
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RZ/N2H Group

Encoder I/F HIPERFACE DSL Safety sample program

Channel Port Name Pin Header | Input/Output Voltage Description
Domain
HFDSL5 ENCIFDIO5 (dsl_in) CN43 #14 Input VDD1833_6 | Data input
ENCIFDOO05 (dsl_out) CN43 #12 Output VDD1833 6 | Data output
ENCIFOEOQS (dsl_en) CN43 #10 Output VDD1833_6 | Drive/receive control
HFDSL6 ENCIFDIO6 (dsl_in) CN42 #18 Input VDD1833_3 | Data input
ENCIFDOO06 (dsl_out) CN42 #16 Output VDD1833_3 | Data output
ENCIFOEOQ6 (dsl_en) CN42 #14 Output VDD1833_3 | Drive/receive control
HFDSL7 ENCIFDIO7 (dsl_in) CN42 #36 Input VDD1833_3 | Data input
ENCIFDOOQ7 (dsl_out) CN42 #34 Output VDD1833_3 | Data output
ENCIFOEOQ7 (dsl_en) CN42 #24 Output VDD1833_3 | Drive/receive control
HFDSL9 ENCIFDIO9 (dsl_in) CN51 #18 Input VDD1833_2 | Data input
ENCIFDOQ9 (dsl_out) CN51 #16 Output VDD1833 2 | Data output
ENCIFOEQ9 (dsl_en) CN51 #14 Output VDD1833_2 | Drive/receive control
HFDSL10 | ENCIFDI10 (dsl_in) CN51 #27 Input VDD1833_2 | Data input
ENCIFDO10 (dsl_out) CN51 #25 Output VDD1833_2 | Data output
ENCIFOE10 (dsl_en) CN51 #23 Output VDD1833_2 | Drive/receive control
HFDSL11 | ENCIFDI11 (dsl_in) CN51 #26 Input VDD1833_2 | Data input
ENCIFDO11 (dsl_out) CN51 #24 Output VDD1833_2 | Data output
ENCIFOE11 (dsl_en) CN51 #22 Output VDD1833_2 | Drive/receive control
HFDSL13 | ENCIFDI13 (dsl_in) CN43 #32 Input VDD1833_6 | Data input
ENCIFDO13 (dsl_out) CN43 #30 Output VDD1833_6 | Data output
ENCIFOE13 (dsl_en) CN43 #28 Output VDD1833_6 | Drive/receive control
HFDSL14 | ENCIFDI14 (dsl_in) CN42 #35 Input VDD33 Data input
ENCIFDO14 (dsl_out) CN42 #33 Output VDD33 Data output
ENCIFOE14 (dsl_en) CN42 #31 Output VDD33 Drive/receive control
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RZ/N2H Group

Encoder I/F HIPERFACE DSL Safety sample program

3.3 Procedures on Development Environments: CR52 ver.

3.3.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN27.
Select higher-numbered port from COM ports that appear at connecting the board with the host PC.
The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for Arm (EWARM)

Version 9.60.3 + patch (EWARM_Patch_for RZT2H N2H rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2025-12
RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure of the Sample Program
The build procedure for the sample program is as follows.

1 Extract RZ_N2H_CRS52_hfdsl.zip and copy the extracted source files to the desired location.
Activate EWARM.

Select [File] menu -> [Open Workspace].

Open the extracted source file RZ_N2H_hfdsl.eww.

Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

a b wN

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.
If the path written as RASC_EXE_PATH in the buildinfo.ipcf file does not match with your rasc.exe
installation path, please edit the buildinfo.ipcf to fit with your installation path.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.

R11AN0974EJ0400 Rev.4.00 Page 7 of 15
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RZ/N2H Group Encoder I/F HIPERFACE DSL Safety sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rz,
rz_cfg, rz_gen, script and .setting folders will be generated.

E CA1_Prog\Work\Work C\Work EWA_960_3 fsp4.0.0RZN2H_HFDSL_Safety_release_chk - FSP Smart Cenfigurator - [m] x
File Window Run Help

£ [RZNZH_HFDSL_Safety_release_chi] FSP Configuration iy 7 FSP Visualization = a8

Summary 0 F =}

Generate Proje-t Content

Project Summary RENESAS

Board: RZN2H Evaluation Board (RAM execution without flash memory)

Device: ROADSGOBTM44GBG

Core: CR52CPUO

FSP Version: 4.0.0

Project Type: Flat

Location: C:/1_Prog/Work/Work_C/Work_EWA_96....0/RZNZH_HFDSL_Safety_release_chk |

Selected software components
Arm CMSIS Version 6 - Core v6.1.0+fsp.4.0.0

RZN2H Evaluation Beard Support Files (RAM execution without flash memory) v4.0.0
Memory Config Checking v4.0.0

)EO

Summary | BSP| Clocks | Pins| Interrupts| Event Links| Linker Sections | Stacks| Components > Al

[ Properties [ Problams M ¢ = O B console (i)

No consoles to display at this time.

| Properties are not available.

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild All] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_N2H_hfdsl.out is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see 4.11.6
console commands in the RZ/N2H Group HIPERFACE DSL Safety Sample Program Application Note.

1 COMI0 - Tera Term VT
T7A IR (5)  JvhHO-JL0)

"REE D)

ALT(H)
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RZ/N2H Group
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3.3.3 e? studio from RENESAS

(1) Build Environment

RENESAS e? studio 2025-12
Toolchain version: GNU Arm Embedded 13.3.1.arm-13-24
RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
SEGGER J-Link™ v8.60

(3) Build Procedure of the Sample Program

The procedure for building the sample program is as follows.

1 Extract RZ_N2H_CRS52_hfdsl.zip and copy the expanded source file to any location.

2 After launching e? studio and moving to the workspace, click the [File] menu-> [Import] and select
Existing project to workspace and click [Next].
3 On the project import screen, select the folder where the sample program was expanded as the root

directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].
5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

File Edit Source Refactor Navigate

W ifr v Q-

|®-&~iq

Praject Explarer = 8

| ~ =% RZ_ N2H_hfdsl [Debug]
> [ Includes

[ conrgurstomen] |
= RL_NZA_hraslelt)linl
X| RZ_N2H_hfdsl.elflaunch
> () Developer Assistance

1488 configuration.xml - RZ_N2H_hfds|

Problems Cansale

0 errors, 11 warnings, 0 others
=
Description

» & Warnings (11 items)

Search Project RenesasViews Run Renesas365 Window Help
Q, & Not Connected
= 8

There is no active editor
that provides an outline,

Properties Smart Browser Smart Manual

Rescurce Path

Location

5 ||M@ e

Outline

Type

=8 s

[h]
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RZ/N2H Group Encoder I/F HIPERFACE DSL Safety sample program

6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rz, rz_cfg, rz_gen, script, .settings folders are generated.

[ {8 RZN2H_HFDSL_Safety_release_chi - RZ_N2H_hfdsl/configurationxml - & studio = o bd
[ File Edit Source Refactor Mavigate Search Project RenesasViews Run Renesas365 Window Help
| ®-K - withe Q- Q&) NotConnected | F

=D Outline % =8

| ProjectBxplorer x = B {5} [RZ_N2H_hids] FSP Configuration 5

B G i o SHER N

c Summary Generate Project Content
| ¥ I5 RZ_N2H hfds| enerate Project Lontent ' § 11 ere is no active editor that
il Includes provides an outline.
8 src Project Summary .
enesas
| RZ_N2H _hfdsl.elfjlink Board RZN2H Evaluation Board (RAM execution without flash memory)
| RZ_NZH hfdslelflaunc | Device: RYADSGOBTM44GBG
(%) Developer Assistance Core: CR52 CPUD
Toolchain: GCC for Renesas RZ
Toolchain Version: 13.3.1.arm-13-24
FSP Version: 400
Project Type: Flat
Location: C:/1_Prog/VorkiWork_C/Work_E2S_RZ...L_Safety_release_chk/RZ_N2H_hfdsl ==

Selected software components

Arm CMSIS Version 6 - Core v6.1.0+fsp.4.0.0
RZN2H Evaluation Board Support Files (RAM execution without flash memory) v4.0.0
Memory Config Checking v4.0.0 o

NEO

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Linker Sections | Stacks| Components

Problems %X Console Properties Smart Browser Smart Manual g =0
Qerrors, 11 warnings, 0 others
Description Resource Path Location Type

% Warnings (11 items)
7 Select [Project] menu -> [Build All].
The Debug\RZ_N2H_hfdsl.elf file is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading to internal RAM.
3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see 4.11.6
console commands in the RZ/N2H Group HIPERFACE DSL Safety Sample Program Application Note.

M COMI0 - Tera Term VT - O x|
(S) IVEO-IO)  PUEIW) ALTH)
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3.4 Procedures on Development Environments: CA55 ver.

3.4.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN27.
Select lower-numbered port from COM ports that appear at connecting the board with the host PC.
The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.4.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for Arm (EWARM)

Version 9.60.3 + patch (EWARM_Patch_for RZT2H N2H rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2025-12
RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure of the Sample Program
The build procedure for the sample program is as follows.

1 Extract RZ_N2H_CA55_hfdsl.zip and copy the extracted source files to the desired location.
Activate EWARM.

Select [File] menu -> [Open Workspace].
Open the extracted source file RZ N2H_CA55 0_hfdsl.eww.
Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

a b wWwN

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.
If the path written as RASC_EXE_PATH in the buildinfo.ipcf file does not match with your rasc.exe
installation path, please edit the buildinfo.ipcf to fit with your installation path.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.

R11AN0974EJ0400 Rev.4.00
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RZ/N2H Group Encoder I/F HIPERFACE DSL Safety sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rz,
rz_cfg, rz_gen, script and .setting folders will be generated.

CA1_Prog\WorkiWork_C\Work_EWA_960_3_fsp4.0.0NRZN2ZH_HFDSL_Safety_CAS5 release_chk - FSP Smart Configurator - [m] X

File Window Run Help
{5} [RZNZH_HFDSL Safety CASS_release chi] FSP Configuration =l “% FSP Visualization =8
) : S5 N

Summary Generate Project Content L

Project Summary ReENESAS

Board: RZN2H Evaluation Board (RAM execution without flash memory)

Device: ROADSGOBTM44GBG

Core: CAS55 Corel

FSP Version: 4.0.0

Project Type: Flat

Location: C:/1_Prog/Work/Work_C/Work_EWA_96..N2H_HFDSL_Safety_CAS5_release_chk <5

Selected software components

Arm CMSIS Version & - Core v6.1.0+f5p.4.0.0
RZN2H Evaluation Beard Support Files (RAM execution without flash memory) v4.0.0

Memory Config Checking v4.0.0

DNEO

Summary | BSP| Clocks | Pins| Interrupts| Event Links| Linker Sections | Stacks| Components > Al

[ Properties [2) Problems M ¢ = 8 ECdonole
| No consoles to display at this time.
| Properties are not available.

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\ RZ_N2H_CA55_0_hfdsl.out is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see 4.11.6
console commands in the RZ/N2H Group HIPERFACE DSL Safety Sample Program Application Note.

1 COM10 - Tera Term VT
JrAILF REE

37 H0-JL0)

TAUFIW)
rt

Al T(H)
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RZ/N2H Group Encoder I/F HIPERFACE DSL Safety sample program

3.4.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2025-12
Toolchain version: GCC Arm A-Profile (AArch64 bare-metal) 13.2.1.20231009
RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
SEGGER J-Link™ v8.60

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_N2H_CA55_hfdsl.zip and copy the expanded source file to any location.

2 After launching e? studio and moving to the workspace, click the [File] menu-> [Import] and select
Existing project to workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root

directory.

Select a project, check Copy Project to Workspace, and click [Finish].

Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

[$2 0" N

Q RZN2H_HFDSL_Safety_CAS5_release_chk - & studio = m] x |

File Edit Source Refactor Mavigate Search Project RenesasViews Run Renesas 365 Window Help
| IR W n s @~ Q, &Y Not Connected ﬁl g C/c++ |
Praject Explarer = 8 = B Outline X =8 =

7 8 There is no active editor that '-E’.“

H
v [z5 REZ_N2H_CAS55_0_hfdsl [Debug] provides an outline,

> [l Includes
e

52 configuration.xml

= R_MZH_UASS_U_hrdslelfjlink
X| RZ_N2H_CA55_0_hfdsl.elflaunc
5 (7) Developer Assistance

dr

Problems ¢ Console Properties Smart Browser Smart Manual 7 § = B8

Qerrors, 11 warnings, 0 others
~

Description Resource Path Location Type

> & Warnings (11 items)

i:—:_?’ configuration.xml - RZ_N2H_CA55_0_hfds|

A
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RZ/N2H Group Encoder I/F HIPERFACE DSL Safety sample program

6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rz, rz_cfg, rz_gen, script, .settings folders are generated.

| 8} RZN2H_HFDSL_Safety_CASS_release_chk - RZ_N2H_CA55_0_hfdsl/configurationaml - & studio - o X
| File Edit Source Refactor Mavigate Search Project RenesasViews Run Renesas 365 Window Help
®-K - witse Q- Qi &) NotConnected |
Praject Explarer X = O {8} [RZ_N2H_CAS55 0_hfdsl] FSP Configuration X iy Cutline X =8
== g =N 2
| = £ Summary 1% 8 @
v 75 RZ_N2H CAS5 0 hfdsl [Debug Generate Project Content f i 1o active editor that
| [ Includes provides an outline.
[ src Project Summary )
“ENESAS
| RZ_N2H_CA55_0_hidsl.elijlink | Board: RZN2H Evaluation Board (RAM execution without flash memory)
¥ RZ_NZH_CASS.0 hidslelilaur | Device: RIADIGOETMAAGEG
| (?) Developer Assistance Core: CAS55 Corel
Toolchain: GCC for Renesas RZ (A-Profile AArch64 bare-metal)
Toolchain Version: 13.2.1.20231009
FSP Version: 400
Project Type: Flat
Location: C:1_Prog/WorkMork_C/Work_E2S_RZ...5_release_chk/RZ_N2H_CAS5_0_hfdsl ==

Selected software components

Arm CMSIS Version 6 - Core v6.1.0+fsp.4.0.0
RZN2H Evaluation Board Support Files (RAM execution without flash memery) v4.0.0
Memory Cenfig Checking v4.0.0 -

EO

Summary | BSP | Clacks| Pins | Interrupts | Event Links | Linker Sections | Stacks | Components

Problems X Console Properties Smart Browser Smart Manua! g =0
O errors, 11 warnings, O others
Description Resource Path Location Type

% Warnings (11 items)

4% configuration.xml - RZ_N2H_CA55_0_hfds|

7 Select [Project] menu -> [Build All].
The Debug\RZ_N2H_CA55_0_hfdsl.elf file is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading to internal RAM.
3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see 4.11.6
console commands in the RZ/N2H Group HIPERFACE DSL Safety Sample Program Application Note.

T COMI0 - Tera Term VT - (] x|
IR REE (S JI¥O-IWG)  FAUEW) ALTH)
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Revision History

Description
Rev. Date Page Summary
2.00 Dec 23.24 - First Edition issued
3.00 Nov 14.25 1 Update description of the trademarks.
2,3 Update revisions of the application note and the release note.

Update sample program version to 3.0. (Support FSP v3.0.0.)
Update file structure.

4 Update memory size information.
71014 Update build environment for FSP v3.0.0. Replace Figures.
4.00 May 08.26 2,3 Update revisions of the application note and the release note.

Update sample program version to 4.0. (Support FSP v4.0.0.)
Update file structure.

4 Update memory size information.
71014 Update build environment for FSP v4.0.0. Replace Figures.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LS| are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.

- HIPERFACE DSL is a registered trademark of SICK AG.

- IAR Embedded Workbench is a registered trademark of IAR Systems.

- J-Link is a trademark of SEGGER Microcontroller GmbH.

- Arm and Cortex are registered trademarks of Arm Limited (or its subsidiaries) in the EU and/or elsewhere.
All rights reserved.

- Additionally all product names and service names in this document are a trademark or a registered
trademark which belongs to the respective owners.




Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1  October 2020)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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